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1 Introduction and Software Installation 
 

1.1 Introduction and Device Compatibility 

The MotionWare software provides analysis functions for sleep, circadian rhythm and physical 
activity alongside device and data management tools within one integrated solution. The 
accelerometer data from our devices is interpreted by the software algorithms to provide the 
data end points. An intuitive graphical user interface provides valuable insights into subject 
behaviour while providing flexible data selection and reporting tools. 
 
MotionWare is compatible with the following CamNtech devices and utilities: 
 

MotionWatch 8 A compact and light-weight wrist or body worn Actigraphy 
and light sensor. 

See MotionWatch User Guide ref 30147 for details of the 
device. 

MotionWatch R Ruggedized version of the MotionWatch 8 primarily 
intended for veterinary applications or use in harsh 
environments.  

See MotionWatch User Guide ref 30147 for details of the 
device. 

Nano The Nano is an ultra-miniature, Bluetooth enabled 
actigraphy device intended for veterinary use with smaller 
animals.  

See Nano User Guide ref 30226 for details of the device. 

PRO-Diary The PRO-Diary is a wrist-worn electronic Patient Diary 
with built-in actigraphy. MotionWare may be used to 
analyse actigraphy data from the PRO-Diary however the 
PRO-Diary also has its own device management software. 

See PRO-Diary user guide ref 30119 for details of the 
device. 

CDM (Cloud Data 
Manager) 

The CDM is an integrated software solution that allows the 
secure collection and management of device data from 
remote sites. The CDM is a subscription-based add-on 
and requires a simplified version of the software to be 
installed at remote (branch) sites. 

See CDM HQ user guide ref 30177  

and CDM Branch user guide ref 30178 for details. 

 
Please consult the device user guides for relevant regulatory, safety and handling 

requirements when using the system. 
 

 

  

https://www.camntech.com/motionwatch-8/
https://www.camntech.com/Products/MotionWatch/The%20MotionWatch%20User%20Guide.pdf
https://www.camntech.com/motionwatch-r/
https://www.camntech.com/Products/MotionWatch/The%20MotionWatch%20User%20Guide.pdf
https://www.camntech.com/nano/
https://www.camntech.com/Products/Nano/Nano%20User%20Guide.pdf
https://www.camntech.com/pro-diary-m/
https://www.camntech.com/Products/PRO-Diary/PRODiaryUserGuide.pdf
https://www.camntech.com/Products/MotionWatch/Server%20Data%20HQ%20Guide.pdf
https://www.camntech.com/Products/MotionWatch/Server%20Data%20Branch%20Guide.pdf
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1.2 MotionWare Installation 

System Requirements  

The following are the minimum requirements of a Windows PC for installing the MotionWare 
software:  

• Windows® 8, 10 or 11 32 or 64bit operating systems. 

• 2GHz + processor speed recommended 

• 500 MB available disk space 

• One free USB port 

• Bluetooth (only required for BT enabled devices) 

• SVGA graphics card (1280 x 1024) recommended 
 
CamNtech recommends the following minimum security requirements for the host PC: 

• Use of strong user login passwords 

• Enabling of automatic Windows updates 

• If the host PC is networked, use of Windows Firewall (or third-part alternative) – 
ensuring updates applied 

• Use of Windows Defender anti-malware (or third-party alternative) with automatic 
definitions updates enabled. 

 
The MotionWare software is also available for Mac computers, where the minimum 
requirements are: 

• macOS 10.13 or greater. 

• 500 MB available disk space 

• One free USB port. The MotionWatch will be supplied with a rectangular USB “Type A” 
cable. You will need a standard adaptor to connect this to some USB-C only devices. 

 
CamNtech recommends the following minimum security requirements for the Mac computer: 

• Use of strong user login passwords 

• Enabling of automatic operating system updates 
 
CamNtech recommends that our devices are not connected to any PC other than a dedicated 
host PC which meets the above requirements and is running the MotionWare software.  
 
How to access MotionWare 

First register your new software on our website: www.camntech.com/register. This will create 
a new account and link your account to the software. For users who already have an account, 
please contact us to add your new software licence to your existing account. 
You will require the reference number supplied with MotionWare software license (in the 
format 11/999) to register. 
Your account will normally be activated within 24 hours and you will be sent an email 
containing your software serial number. 
After your account is activated, log-in by clicking ‘My account’ in the top banner; your account 
home page will contain the links to download your registered software. Your software has a 
standard license period of 2 years in which time you may log-in and download any updates as 
required. 
The software will continue to be fully functional beyond the licence period but updates will no 
longer be provided. Note that CamNtech standard software licensing allows up to 3 users to 
register and use one copy of the software. 
 
MotionWare can also be supplied on a USB drive at a small additional cost – please contact 
us for details. 

https://www.camntech.com/register/
mailto:admin@camntech.co.uk
mailto:admin@camntech.co.uk
mailto:admin@camntech.co.uk
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1.3 How to Install MotionWare 

To install MotionWare for Windows, login to our website and download the Windows installer 
(.msi) from the CamNtech website: www.camntech.com/downloads  
 
Double click on the downloaded .msi file to run the installer then follow the installation 
process.  
 
To install MotionWare for Mac, login to our website and download the installer image (.dmg) 
from the CamNtech website: www.camntech.com/downloads 
 
Double click on the downloaded .dmg file to open the installer image. This will display an icon 
for the MotionWare software alongside the icon for your computer’s Applications folder. Drag 
the MotionWare icon onto your Applications folder to install. 
 

1.4 Updating MotionWare 

Follow the same procedure for installing MotionWare in section 1.3 above; the software will be 
updated to replace the existing version. Note that any data and settings will not be lost during 
the update. 

 
 

1.5 Software Serial Number 

Double click on the MotionWare icon on the Windows desktop or start menu to start the 
software, or select MotionWare from Launchpad on your Mac.  
 
The software will run for a 30-day evaluation period, after which the software serial number 
will be required. 
 

To enter the software serial number, open the Settings window ( →Settings), then click 
‘View or enter software serial number’.  
 
When you have received your serial number, enter the 8 digits and then click the ‘Apply Serial 
Number’ button. 

 
 

If you do not have a serial number, please click the ‘Get Serial Number’ button to link to the 
CamNtech website and follow the instructions from section 1.2 above to access and register 
the software. 

https://www.camntech.com/downloads
https://www.camntech.com/downloads
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2 MotionWare Configuration 

2.1 Running MotionWare 

Double click on the MotionWare icon on the Windows desktop or start menu to start the 
software or select MotionWare from Launchpad on your Mac. If a MotionWatch is connected it 
will be automatically detected and the MotionWatch Manager screen will be displayed. The 
front screen of the software with no MotionWatch connected will be similar to that shown 
below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.2 MotionWare Settings 

Click on the Settings button on the start-up screen to open the MotionWare settings window. 
Here you may change the software configuration to your own preferences. 
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View or Enter Software Serial Number 

Click this button to open the serial number entry window, described in Section 1.5 ‘Software 
Serial Number’ above. 

 
Set Institution Name & Logo (for printouts) 

You may choose to enter an institution name in the settings window, which will then be 
included near the top of all printed reports. This window also contains an option to load your 
institutional logo in .jpg or.png format and choose how to align the logo. This may be desirable 
if you wish to hand the actogram or other reports directly to participants after use. 

 
Default Action for Recent items 

Choose whether to open the data with either Sleep analysis or Daytime Activity Analysis upon 
double click in the recent items list. 
 

Default Remarks for New Recordings 

You may enter some default remarks which will be included with all new recordings. This is 
useful if you wish to have a template for comments/remarks which is applied to all recordings. 
You may further edit the remarks from the main software later. 

 
Warn if new Firmware available 

New firmware (software that is programmed into the device) is sometimes provided within the 
software update. Check the ‘Warn if new firmware available’ selection to be automatically 
notified if new firmware is available. 

 
Automatically show the MotionWatch Manager… 

Controls whether to automatically show the MotionWatch Manager Window when a 
MotionWatch is connected to the computer. 

 
Show Cloud Data Manager Buttons in Main Menu 

For customers not using the Cloud Data Manager, it may be desirable to hide the buttons form 
the main menu screen. 
 

Start Background Scanning for Nano Devices on Startup 

Applies to Nano only – the software can begin looking for any local Nano devices when 
MotionWare is started. This can speed up the listed devices in the Nano Connections window. 
See the Nano User Guide for information about nano Connections. 
 
Change Usage Data Collection Settings 

CamNtech would like to collect metrics regarding how the software is used to help improve 
future releases. No patient related data are collected and the usage data collection is entirely 
optional. 
 
View Nano Download Reminders 

Applies to Nano Only – During setup of scheduled Bluetooth hours, it is possible to set-up 
reminders to download the Nano at the scheduled times. The reminders use the in-built 
Windows or MacOS notification service which will create a pop-up at the bottom corner of the 
screen. MotionWare does not need to be running however, reminders are subject to the 
limitations of the notification service.  
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Updates 

The software will automatically check for updates each day it is used, but this feature can be 
disabled using the “Automatically Check…” tick box. 
 
You can also choose to manually check for updates from the button here. This will connect to 
the CamNtech website immediately to check if updates are available.  
We recommend keeping your software up-to-date when possible. Ideally, updates should be 
applied in-between data collection projects and avoided during them unless there is a specific 
need. 
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3 Setting up and Downloading Data 
 

Each CamNtech device will have its own specific set-up and Download which is detailed in 
each of the device User Guides as follows: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

MotionWatch 8 MotionWatch User Guide ref 30147  

• Section 2 for how to set-up the device. 

• Section 3 for how to download (view) the data. 

MotionWatch R MotionWatch User Guide ref 30147 

• Section 2 for how to set-up the device. 

• Section 3 for how to download (view) the data. 

Nano Nano User Guide ref 30226 

• Section 3 for how to set-up the device. 

• Section 4 for how to download (view) the data. 

PRO-Diary PRO-Diary user guide ref 30119 

• Section 4 for how to set-up the device for Motion Logging 

• Section 7 for how to download (view) the Motion data. 

https://www.camntech.com/motionwatch-8/
https://www.camntech.com/Products/MotionWatch/The%20MotionWatch%20User%20Guide.pdf
https://www.camntech.com/motionwatch-r/
https://www.camntech.com/Products/MotionWatch/The%20MotionWatch%20User%20Guide.pdf
https://www.camntech.com/nano/
https://www.camntech.com/Products/Nano/Nano%20User%20Guide.pdf
https://www.camntech.com/pro-diary-m/
https://www.camntech.com/Products/PRO-Diary/PRODiaryUserGuide.pdf
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4 Preparing to Analyse Data 

4.1 Selecting Recent Recordings 

When data are saved following download, the file automatically appears in the ‘Recent 
Recordings’ list on the front screen of the software. The recent recordings list provides a quick 
access method to the most recently opened or downloaded files. 
 
It is possible to adjust the recording for daylight saving – see section 5.13 below for more 
information. 

 
 
Click once on a file in the ‘Recent Recordings’ list to select it; more details of the file are 
displayed in the information pane below. The file can be opened after selection by clicking on 
the ‘Open selected recording’ button. Alternatively, double clicking on the file will open the file 
directly (choose the default analysis type to open with double click in MotionWare Settings). 
Right click on the file for more options. 

 

4.2 Managing Recent Recordings 

If the recent recordings list becomes full or cluttered, it is possible to remove entries from the 
list or to fully delete the related file. To manage the recent recordings, right click on the 
required file name in the list to show a pop-up menu with the following options: 
 

 
 
 

 

 

 

 

 

Recent Recordings: Click an item to 
view the file details in the information 
pane then open by clicking the Open 
Selected Recording button. 
Alternatively, double click an item to 
open directly. Where a file is a legacy 
file-type, this will be shown in the list 
entry. 

Open in Sleep Analysis: Click to 
open the item selected in the Recent 
Recordings list with Sleep Analysis. 

Information Pane: Provides more 
detail about the selected recording. 

Open in Physical Activity / Day 
Analysis: Click to open the item 
selected in the Recent Recordings list 
with Physical Activity Analysis. 

Browse for Motion File: Opens file 
manager dialog to select a file. 
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Remove from list will keep the file on the disk but remove it from the list; the 
file will not be deleted.  

Delete File will remove from the list and delete the file from the disk. A 
warning message will be displayed before the file is permanently deleted. 

Show Folder will open an Explorer window in Windows, or a Finder window 
on macOS, to show the folder the recording file is located in. 

Clear Recent Items List will remove all files from the list – the files will not be 
deleted. 

Properties allows the recording details to be viewed. 

 

4.3 Browse for Recordings 

It is also possible to locate and load recordings that do not appear in the Recent Recordings 
list. From the main screen, click on the ‘Browse…’ button to find and select another file. Use 
the folder controls to browse to the location of the required files. Note that the default file 
format is .MTN (depicting MoTioN) and this type of file will be displayed automatically. It is 
possible to change the file-type filter to browse for other file types (see below). 

 

4.4 Import Legacy Recordings 

Certain legacy products (such as CamNtech Actiwatch) used an open file format, hence it is 
possible to directly load existing .AWD or .AWF format files. To import a legacy file, follow the 
instructions to browse for a file in Section 4.3 above and then change the file-type filter to 
‘Actiwatch (*.AWD)’ or ‘Actiwatch Fast (*.AWF)’: 
 

 
 

 
It is also possible to import saved data from Legacy Philips Actiwatch Spectrum and AW2 by 
selecting ‘Actiware Import (*.CSV). The export data from Actiware must be correctly formatted 
to load into MotionWare. Please see appendix A for details of importing Actiware data. 
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4.5 The MotionWise Window 

When a recording is opened the MotionWise window is displayed: 
 

 
 
The MotionWise window provides a multiple-day, single or double plotted motion graph 
(actogram) within a flexible, scalable and scrollable window. The MotionWise window is the 
key tool for the selection of data for more detailed analysis. The top region of the window 
provides summary patient information. The entire window may be stretched and dragged by 
manipulating the corners of the window. The window can also be maximised to fill the full 
screen by using the window control. 
 
Scroll through the days by using the slider control at the right hand side of the screen, mouse 
scroll wheel, or touchpad scrolling. 
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4.6 The MotionWise Graphs 

For each day containing data, a graph similar to that shown below will be displayed.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

4.7 MotionWise Graph View Options 

The Actogram view can be adjusted for different purposes using the window below. This is 
found under the ‘Options’ item in the ‘View’ menu. The Actogram will adjust to give immediate 
feedback after you have changed any of the options. 
 

 
 

Row Length 

Select 24- or 48-hour graphs to show single or double plotted actograms respectively. Each 
row of the graphs will then correspond to the length chosen, but the change forwards between 
rows will be 24 hours in both cases. 

 
Row Height 

Using this slider, you can adjust the heights of each row of the Actogram to show lots of detail 
on each graph, or very compressed rows to present a longer time period onscreen. Note that 
the range available here depends on the setting of the ‘Horizontal scale’ below.  
 

Reduce 
Activity 

Scale 

Reduce 
Light 
Scale 

Increase 
Activity 

Scale 

Increase 
Light 
Scale 

Activity Plot 
(Black) 

Light Plot 
(Yellow) 

Event Marker 
(Blue) 

No Data 
(Grey) 
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Start Rows at 

The MotionWise graphs default to a plot start time at the start of the recording. However, 
when comparing data between multiple users, it can be useful to have a fixed start time for the 
plots. So you can select either to always start from the beginning of the recording, or enter a 
fixed time in the text box. 

 
Horizontal Scale 

Using this option, you can choose to show self-contained graphs with a horizontal scale on 
each row, or close-fitted graphs with no horizontal axis on each. In the latter case, a time 
scale is added at the top and bottom of the actogram instead. 

 
Finer Detail Grid Lines 

Show or hide the light grey hourly grid lines on the graphs (these will also depend upon the 
resolution of the monitor or printer). 

 
Default Opening Graph Scales 

The initial (default) scales for activity, light and temperature may be set here. 
 

4.8 Printing the MotionWise Graphs 

You may produce a printed copy of the MotionWise graphs covering all days of data, by 
selecting the ‘Print preview” option from the ‘File’ menu. This preview allows you to view and 
step through all of the report pages using the ‘<’ and ‘>’ buttons.  
 
The printed Actogram can be adjusted similarly to the on screen Actogram by clicking the 
‘Actogram Options’ button. This includes an additional setting to include or exclude a list of the 
recording properties with the Actogram printout. 
 

4.9 Selecting the Analysis Period 

There are three main selection options which may be chosen by use of the control buttons in 
the MotionWise window: 
 
 
 

 
Select Any 

The ‘Select Any’ option provides a flexible means of selecting any analysis period between 
your chosen start and end points. 
 
In the MotionWise window, choose the period of data for analysis by pointing at the start point, 
hold down the left mouse button and then drag to select the period required. The selected 
period is highlighted and the Analysis window is automatically displayed. The figure below 
shows a single overnight period selected:  
 
 
 
 
 
 

 
 

For sleep analysis - Select the period to start 
before the activity ends or lights out. 

For sleep analysis - Select the period to 
end after the activity starts or lights on. 
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It is possible to select anywhere between a very short period (i.e. a few minutes) to several 
days using this method. By dragging off the bottom or top of the MotionWise graph area, the 
window will automatically scroll to allow selection of days that are not currently displayed. 

 
Select Days 

The ‘Select Day(s)’ option will select a period starting and ending at midnight on the chosen 
day(s). To make a selection, point anywhere within the graph on the day of interest, hold down 
the left mouse button and then drag to select the day(s) required. Drag across multiple graphs 
to select several days and drag off the bottom or top of the MotionWise graph area to 
automatically scroll while selecting. 
 
Select All 

The ‘Select All’ option allows a one-click selection for all days of data ready for a multiple day 
analysis such as NPCRA. 
 

4.10 Saved Periods and Longer Periods 

The Analysis functions allow the selected periods to be saved. These periods will remain 
highlighted in the MotionWise Window and the analysis can be quickly re-opened by clicking 
anywhere in the highlighted region. If the saved period is longer than 24 hours (i.e. for an 
NPCRA analysis) then the highlight is not shown in the graph. These longer saved periods 
may be chosen from the ‘Longer periods’ menu in the MotionWise Window. 
 

4.11 Editing Data 

It is possible to edit periods where there is believed to be some problem with the recorded 
data to change or remove the activity during that period. This may be necessary where for 
example the watch was not worn for a period, or where it is believed an activity gave 
particularly misleading activity counts for analysis purposes. The Edit function may be 
accessed by selecting a period for analysis in the manner described in Section 5 ‘Sleep 
Analysis’, then selecting the Edit analysis function from the list in the bottom-left of the 
window. 
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After selecting the Edit tool, it is possible to fine tune the time period for the edit either by 
dragging the ‘Start’ and ‘End’ bars on the graph, or by changing the text boxes containing 
times below the graph. 
Next you must choose to change either the ‘Activity’ or ‘Light’ channel as appropriate. Note 
that marking missing data will cause both to be considered as missing. 
 
The data samples within the selected period can be changed in four different ways: 

Missing Data 
This option will set the data as missing, where the period is shown with a 
grey background, and analysis functions which take an average will 
ignore the missing samples. 

Fixed Value 
This option will set the data samples (either activity or light) to the value 
entered in the box. 

Average of… This option will set the data samples to either the average of the entire 
day (including the selected period), or the average of the day excluding 
the selected period (rest of day). There is also the option to replace the 
period with the average for the same period on the days before and after. 
The day is taken as the 24-hour period between midnights which 
contains the start time of the edit. 

Original Data This option allows you to restore the original values first recorded before 
any edit took place. All of the data and changes are contained as an 
audit log within the motion file allowing them to be restored. 

 
If there is a period at the end of your valid data with empty days (i.e. watch was not worn) then 
select all the time after the valid recording and mark it as missing data. This will exclude it 
from reports and printouts. Data can be restored at any point using the “Original data” option 
above. 

4.12 Generating Reports 

In the MotionWise window select ‘Tools -> Report’ to open 
the report generator window. This tool provides a number 
of flexible reporting options which are discussed in more 
detail below.  It also provides a live preview so the results 
of changes can be seen immediately. The preview window 
may be opened using the ‘Print Preview…’ button. 

Include Recording Properties 

Select this option to include the User ID, Gender, DoB, 
Device information, start time and other properties within 
the report. 

Include Recording Properties 

Use this option to show/hide the full path and file names in 
reports (may be useful if path or filename contains 
sensitive information). 

Include Markers 

Select this option to include a date/time stamped listing of 
marker events within the report. 
Include Sleep Analysis 

Select this option to include full Sleep Analysis results for 
all saved analysis periods within the report (see Section 5 
Sleep Analysis). 
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Transpose Table 

Select this sub-option to swap the row/column layout of this specific table within the report.  

Copy with Rounded, Formatted Values 

This sub-option applies to data exported via the clipboard only. When selected, the results will 
contain rounded values with periods formatted as hours and minutes. When un-selected, the 
results will be exported as un-rounded values and periods will be formatted in seconds. The 
latter option is useful when importing data into external packages for further analysis. 

Print in Landscape 

This option swaps the default (portrait) report format to landscape orientation. This can be 
useful to best ‘fit’ the report to the page. This option only applies to printed reports. 

Copy Results Tables (for spreadsheet) 

Having selected the required report options, click the ‘Copy Results Tables’ button to export 
the data. The data may now be imported into external software (e.g. a spreadsheet) for further 
analysis or formatting. 
 
Copy to Word Processor 

Places the selected results and actograms for all days onto the clipboard formatted to paste 
directly into a word processor. This facilitates rapid production of custom reports.  
 
Save as (PDF, RTF, DOC, ODT)… 

The selected results and actograms for all days are saved into your selected file format. The 
available options here will differ slightly between Windows and macOS computers. Choose 
the document type in the ‘Save as type…’ dropdown, choose from the following options: 
 
 
 
 
 
 
 
 
 
 
 
Enter a file name/location to save the file. These options facilitate rapid production of custom 
reports.  
  
Print Preview 

If you have not already opened the live preview window, this button will do so. This will allow 
you to experiment with report options and see how the resulting report presents data and fits 
across multiple pages. 
 
Print 

Having selected the required report options, click the ‘Print’ button to send the report to the 
printer. A standard printer dialogue will be displayed allowing the target printer options to be 
selected. 
 
 

RTF Rich Text Format – open in most word processors. 

PDF Portable Document Format – open in Adobe Acrobat Reader. 
PDF files can also be generated from the print dialog on all 
supported Mac, and most modern Windows computers. 

DOC Microsoft Word Document. 

ODT Open Document – use with Open Office. 
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Filter Visible Columns 

It is possible to further customise the parameters that will be 
included in the report. Click on the ‘filter visible columns’ button 
for either the marker or sleep analysis data. 
A window containing a checklist of parameters will be displayed 
(sleep parameters are shown in this example). Ensure that the 
required parameters are checked for inclusion in the report. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

4.13 Daylight Saving Adjust 

If a clock change is detected (daylight saving) during a recording, a message will be displayed 
upon first opening of the recording:  
 
 
 
 
 
 
 
 

 
 

• Select ‘Yes’ to apply a daylight saving adjustment to the data. This will default to the local 
regional settings of the computer (typically add or remove 1 hour of data at 2am.) This 
can be undone – see 5.14 below. 

• Select ‘No’ to ignore the daylight saving adjustment (Adjustment can be applied later if 
required) 

 
It is possible to apply the daylight saving adjustment by clicking on the ‘Tools’ menu then 
selecting ‘Daylight Savings Adjust’. The following window will be displayed: 
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The adjustment values will be filled in automatically where the operating system supplied 
Daylight Saving Times can be matched to the recording time period. They can however be 
modified if required and then be applied to the data by clicking ‘Apply now’. 
 

4.14 Restore original download 

To reverse (undo) any daylight saving adjustment or any other edits or any saved analysis, 
first close the recording and then re-open it. Then select ‘Restore original download’ from the 
‘Tools’ menu.  
 
A warning will be displayed as follows: 
 

 
 
 
 
 
 

 
Click ‘Ok’ to restore the original download or cancel to keep the adjusted data. Note that all 
edits which have been made to the data will be lost (including any saved sleep periods or 
analysis). 
 

4.15 Combine Epochs 

It may occasionally be desirable to convert data recorded at a shorter epoch into a longer 
epoch (e.g. convert 15s data into 30s data). The software has a built-in function to allow this 
combination. 
 
In the MotionWise window, select ‘Combine epochs…’ from the ‘Tools’ menu. A screen similar 
to the following will be displayed: 
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The current recording epoch will be displayed and a drop-down control provides the available 
options for the new epoch length. 
 
The filename will default to the current file name with the extension ‘_combined’ and will 
default to the current file location (folder). Use the ‘Browse’ button to choose a different file 
name or location. Take care not to over write the original file as this cannot be recovered.  
 
Note that it is not possible to convert longer epochs into shorter epochs. 
 

4.16 Join Files 

It is possible to join (Concatenate) two MotionWatch recordings to create a single recording. 
The recordings must contain the same user details/setup and be concurrent. 

 
1. Load the first data file and open using the sleep analysis function by selecting from 

the list of recent recordings. 

2. From the ‘file’ menu select ‘Join…’ 

3. In the file dialogue, browse and/or select the second motion file that is to be joined to 
the first. 

4. A save dialogue will open to allow the file name and location for the newly joined file 
to be specified. 

5. Click save to save the new file – both original files will be kept unless the joined file is 
given the same name (an overwrite warning will be given in this case). 

6. The new joined file may now be loaded from the recent recordings list. 

7. Any gap between the two recordings will show as ‘missing data’ and will be marked in 
grey. 
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4.17 Importing Body Temperature Data 

If a recording of core body temperature has been made alongside the motion recording using 
a BodyCAP monitoring pill or similar device, you may import the data post-recording and 
combine the two for display. 
 
In order to combine the two recordings, you must first download and open the movement 
recording using MotionWare Sleep Analysis, then select the File -> Import Temperature... 
option from the menu. Choose a .csv file exported from your temperature monitoring 
equipment, and follow the options described below: 
 

• Choose the column separator either by examining the source data, or adjusting until a 

“Capsule” is mentioned in the list below and temperature or date options become 

available in the lower listings. 

• Sub-table Name should present a list including the names of different Capsules. It may 

include other “table names” corresponding to areas of the .csv file without recording data 

– these should not be chosen. 

• Temperature column name is the choice of column header in the .csv file table from 

which to extract temperature results. 

• Date and Time Column names are the choice of column header names for the date and 

time of each temperature sample respectively. 

After import using this window, the temperature data will be shown in red during those time 
periods it is available during the recording.   
 

 
 
Note that only a narrow temperature range around 37C will be visible on the graphs by 
default. This can be adjusted via View -> Options in the menu, and then changing the value 
for Body temperature range. For example, if a value of 2 is set, the graph will include 
temperatures from 37-2 (35) Celsius up to 27+2 (39) Celsius. 
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5 Sleep Analysis 
 

5.1 Introduction 

The Sleep analysis function is designed to provide a number of objective sleep measures from 
overnight actigraphy data. It can be easily applied either to normal overnight periods, or used 
to examine any sleep period from an altered phase recording such as a shift worker.  First 
select a region using the MotionWise window (see Section 4.9 ‘Selecting the analysis period’ 
above) which includes a short period of daytime activity at the start and end. The detailed 
analysis window will be displayed and may initially default to the summary function. To select 
Sleep Analysis, choose ‘Sleep’ from the Analysis Function options at the left of the screen. 
The detailed Sleep Analysis window will be displayed:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Use the mouse to drag the ‘Lights Out’ and ‘Got Up’ markers to the appropriate positions in 
the data, and the thinner red markers inside which denote ‘Fell Asleep’ and ‘Woke Up’ will be 
automatically adjusted from the combination of your markings and the activity data. All of 
these four times are also displayed in the information box below the graph. It is also possible 
to type the times directly into these white fields. 
Where marker events have been used, the software will automatically set the ‘Lights out’ and 
‘Got up’ to the marker times. The process for selecting sleep periods can be automated by 
using the ‘Auto sleep’ function – see section 5.8 below for details. 
 

5.2 Sleep Analysis Statistics 

Once the desired sleep region is selected, the software will automatically perform a 
categorisation of each epoch of the period between ‘Fell Asleep’ and ‘Woke Up’ as either 
‘Sleep’ or ‘Wake’, and also as either ‘Mobile’ or ‘Immobile’, and use these results to provide a 
number of measures from the period.  These are described below: 

 

Click and drag to adjust ‘Lights out’. Click and drag to adjust ‘Got up’. 

Type values into the white fields if 

required. 
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Time in bed The total elapsed time between the ‘Lights Out’ and ‘Got Up’ times. 

Assumed sleep The total elapsed time between the ‘Fell Asleep’ and ‘Woke Up’ 
times. 

Actual sleep time The total time spent in sleep according to the epoch-by-epoch 
wake/sleep categorisation. 

Actual sleep (%) Actual sleep time expressed as a percentage of the assumed 
sleep time. 

Actual wake time The total time spent in wake according to the epoch-by-epoch 
wake/sleep categorisation. 

Actual wake (%) Actual wake time expressed as a percentage of the assumed 
sleep time. 

Sleep efficiency (%) Actual sleep time expressed as a percentage of time in bed. 

Sleep latency The time between ‘Lights Out’ and ‘Fell Asleep’. 

Sleep bouts The number of contiguous sections categorised as sleep in the 
epoch-by-epoch wake/sleep categorisation. 

Wake bouts The number of contiguous sections categorised as wake in the 
epoch-by-epoch wake/sleep categorisation. 

Mean sleep bout The average length of each of the sleep bouts. 

Mean wake bout The average length of each of the wake bouts. 

Immobile mins The total time categorised as Immobile in the epoch-by-epoch 
mobile/immobile categorisation. 

Immobile time (%) The immobile time expressed as a percentage of the assumed 
sleep time. 

Mobile mins The total time categorised as mobile in the epoch-by-epoch 
mobile/immobile categorisation. 

Mobile time (%) The mobile time expressed as a percentage of the assumed sleep 
time. 

Immobile bouts The number of contiguous sections categorised as immobile in the 
epoch-by-epoch mobile/immobile categorisation. 

Mean immobile bout The average length of each of the immobile bouts. 

Immobile bouts <=1min The number of immobile bouts which were less than or equal to 
one minute in length. 

Immobile bouts <=1min 
(%) 

The number of immobile bouts less than or equal to one minute 
expressed as a percentage of the total number of immobile bouts. 

Total activity score The total of all the activity counts during the assumed sleep period. 

Mean activity /epoch The total activity score divided by the number of epochs in the 
assumed sleep period.  Note that this result will be expected to 
scale depending on the length of the epoch. 

Mean nonzero activity 
per epoch 

The total activity score divided by the number of epochs with 
greater than zero activity in the assumed sleep period.  Note that 
this result will be expected to scale depending on the length of the 
epoch. 
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Fragmentation Index The sum of the ‘Mobile time (%)’ and the ‘Immobile bouts <=1min 
(%)’.  This is an indication of the degree of fragmentation of the 
sleep period, and can be used as an indication of sleep quality (or 
the lack of it). 

Threshold The threshold used for analysing movement data.  The 
MotionWatch was validated with a threshold of 20, but this may be 
chosen differently depending on the population. 

Rest per 24h (%) The percentage of epochs in a 24 hour period which would be 
counted as sleep if the whole period were analysed as night time.  
The period runs for 24 hours from midday to midday around the 
“To Bed” time of the analysis.  

Average light (lux) This measure is only present if light was recorded.  It is the 
average light level over the period between falling asleep and 
waking up. 

Central Phase Measure 
(mins) 

This is the midpoint between “Fell asleep” and “Wake up”, 
expressed as the number of minutes past midnight.  For ease of 
normal use, it will be negative for phase times prior to midnight but 
after midday. 

 

5.3 Saving or Removing Analysis Statistics 

With the analysis for the period complete, the analysis may be saved by clicking on the ‘Save 
Sleep Period’ button. The detailed analysis window will close automatically and the analysis 
period will remain highlighted in the MotionWise window. To re-open the saved analysis, 
simply click anywhere on the highlighted region in the MotionWise window. 
 
If the saved analysis is no longer required, click on the ‘Delete Sleep Period’ button in the 
sleep analysis screen to remove it. 

5.4 Adjusting Analysis Threshold 

The threshold used for sleep analysis can be adjusted under the ‘Options’ button. Note that 
the MotionWatch system has been validated with a threshold of 20, so this should normally be 
the default choice. 

5.5 Exporting Sleep Analysis Results 

The ‘Copy Results’ button and ‘Epoch Results’ or ‘Statistics’ options will allow you to transfer 
either the detailed epoch-by-epoch results or the overall statistics easily into a spreadsheet 
program or similar. Simply click the button, transfer to a spreadsheet window on your 
computer, and use the normal Windows paste function to create a table of your results. 

5.6 Printing Sleep Analysis Results 

Click on the ‘Print Preview’ button to preview the report and click on the ‘Print’ button to send 
the report to the printer. 
 

5.7 Sleep Summary Table 

From the MotionWise window, select ‘Sleep Summary Table’ from the ‘Tools’ menu. This 
window provides a summary of the saved Sleep analysis periods. Furthermore, it is possible 
to edit the ‘lights out’ and ‘got up’ times within this window using patient provided information 
(i.e. a sleep diary). 
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To enter data, highlight the required time and then type in the data in HH:MM format. 
 
Click on ‘Save Changes’ when complete and the analysis periods will be automatically 
highlighted in the MotionWise window. Click on any highlighted period to open Sleep Analysis. 
This will perform the analysis on the visible data. After checking the data and results for any 
anomalies, you must then re-save the sleep period to capture the night’s results for the report 
output. 
 

5.8 Auto-Sleep Analysis 

In addition to the manual sleep marking described above, the MotionWare software can also 
automatically analyse an entire recording to detect the periods of sleep, then mark and 
analyse them ready for reporting in a single step. Note however that this function does not 
replace a professional assessment of the data for practical issues, and is not currently 
validated.   
 
Normal Use 

To use the automatic sleep marking function, open a recording in the MotionWise window, 
then click on the Tools menu, and the Auto-Sleep item. This will prompt whether you wish to 
delete any existing sleep periods in the recording, which you must do in order to proceed. The 
window will then present a series of configuration options for the user to adjust if necessary. 
Click on the “Analyse Now” button to proceed. 

The software will now have returned to the MotionWise window with all sleep periods marked. 
You may click to examine each of them, and also use the Report function in the Tools menu to 
view the overall results table from the analysis. 

For initial use, we would recommend leaving the Auto-Sleep Configuration window with 
default settings.  Note that the configuration will remember any changes from previous use; 
suggested values to return to are provided in the software window. 

The Auto-Sleep analysis will be most effective where the wearer’s sleep pattern contains clear 
blocks of good sleep without long waking periods. Note that it does not rely on a daily sleep 
cycle, so is still suitable for shift workers or others with irregular sleeping pattern. Some output 
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measures such as sleep latency rely heavily on the use of the marker button for “Lights Out” 
information. 

 
Auto-Sleep Parameter Adjustment 

Several parameters are available to adjust the behaviour of the automatic analysis if 
necessary to meet your needs. These are described briefly in the Configuration window as 
shown below: 
 

 
 

Sleep Activity Threshold 
(cpm) 

The activity threshold is used both to isolate the sleep period and 
for the sleep analysis itself in the same way as when manually 
marked. Its value can be chosen in the same way as the High / 
Medium / Low settings for the threshold during non-auto sleep 
analysis. 

Minimum Sleep Fraction 
(%) 

This percentage determines how strictly the software will allow the 
extension of an overnight period at its beginning and end.  
Specifying a higher number for sleep fraction will produce a more 
cautious (shorter) estimate of sleep periods. Specifying a lower 
number will produce a more generous (longer) estimate of each 
sleep period. 

Marker Button Limit (hrs) Where a sleep period has been found with marker button presses 
near the suggested start or end point, the time of those presses 
will be used instead of automatic detection if they are within this 
time period. It is suggested that this limit normally be left to allow 
the marker button presses to override the automatic algorithm. 
However, if the wearer has been pressing the button randomly or 
for other reasons, you can reduce this number (to zero if 
necessary). 
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Prescan Sleep Fraction 
(%) 

For initial detection of an overnight sleep period, at least three 
hours of it must reach or exceed this percentage of sleep to qualify 
for further analysis. If your subject’s sleep is particularly broken 
then you may need to reduce this fraction, but it is also likely you 
will have to examine sleep manually in that case. If the wearer is 
particularly inactive during the daytime, you may need to increase 
this percentage to prevent marking of long daytime rests as sleep 
– but again it is likely you may need to examine manually also in 
this case. 

 
Further details of the auto-sleep and conventional sleep analysis algorithms are available from 
CamNtech on request. 
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6 NPCRA Analysis 
 

6.1 Introduction 

Traditional analysis of circadian rhythms has attempted to fit physiological indicators to a 
Cosine waveform shape (Cosinor analysis). Activity-rest data do not typically fit well with this 
type of analysis, hence the MotionWare software provides the function of Non-Parametric 
Circadian Rhythm Analysis (NPCRA). With this approach, we do not assume that the data fit 
any pre-defined distribution. The method used is to analyse full-days of data over several days 
to determine some useful variables which are explained in more detail below. Studies have 
shown that the non-parametric variables are a valuable indicator of rhythm disturbances 
caused by disease or aging and their associated treatments. 

6.2 Reference 

The NPCRA analysis is based upon the work of Dr. Eus Van Someren at the Netherlands 
Institute for Brain Research e.van.someren@nin.knaw.nl 
The original paper published by Dr. Van Someren is: 
 

Van Someren, E J W, DF Swaab, C C Colenda, W Cohen, W V McCall, and P B 
Rosenquist.  Bright Light Therapy: Improved sensitivity to its effects on rest-activity 
rhythms in Alzheimer patients by application of nonparametric methods.  
Chronobiology Int. (1999) 16 (4) 505-518. Click here for link to the paper. 

6.3 Analysis 

NPCRA analysis requires complete data from as many full days as possible. It is not 
recommended to attempt analysis with less than 7 days of data and best results are obtained 
with 14 or more days. 
 
To select the analysis days, use the ‘Select All’ button in the MotionWise screen to 
automatically select all available days. Alternatively, use the ‘Select Days’ or ‘Select any’ tools 
to specify the analysis period (see Section 4.9 Selecting the Analysis Period).  
 
Note also that the analysis is sensitive to periods of inactivity when the MotionWatch has not 
been worn.  
 
Having selected the analysis period, the analysis window will be displayed. Select ‘NPCRA’ 
from the sidebar functions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:e.van.someren@nin.knaw.nl
https://www.camntech.com/publications/bright-light-therapy-improved-sensitivity-to-its-effects-on-rest-activity-rhythms-in-alzheimer-patients-by-application-of-nonparametric-methods/
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6.4 Non-Parametric Variables 

The NPCRA window provides a table of resulting Non-Parametric variables with the following 
meanings: 
 

IS (Interdaily Stability) Quantifies the degree of regularity in the Activity-Rest pattern 
with a range of 0 to 1 where a value of 0 indicates a total lack of 
rhythm and a value of 1 indicates a perfectly stable rhythm. 

IV (Intra-Daily Variability) Quantifies the degree of fragmentation of activity-rest periods. 
Typical healthy subjects will show a single prolonged activity 
period and a single prolonged rest period per 24 hour cycle. 
Certain physiological conditions may lead to multiple short-length 
periods of activity-rest within any 24 hour period. The variable 
has a theoretical range of 0 to 2 with higher values indicating 
higher fragmentation. Typical values for healthy subjects will be 
below 1. 

L5 (Least 5) Average All days of data are overlaid and averaged in 24-hour periods. 
The L5 average provides the average activity level for the 
sequence of the least five active hours. This value provides an 
indication of how restful (inactive) and regular the sleep periods 
are. 

L5 Start Hour Indicates the onset of the L5 sequence and provides an 
indication of the phase of the most restful hours. 

M10 (Most 10) Average All days of data are overlaid and averaged in 24-hour periods. 
The M10 average provides the average activity level for the 
sequence of the highest (most) ten active hours. This value 
provides an indication of how active and regular the wake periods 
are. 

M10 Start Hour Indicates the onset of the M10 sequence and provides an 
indication of the phase of the most active hours. 

RA (Relative Amplitude) First we calculate the Amplitude (AMP) which is the difference 
between the average activity level in the M10 and that in the L5 
periods. To remove sensitivity to overall activity level, we then 
calculate the RA by dividing the AMP by the sum of the L5 and 
M10. The variable has a theoretical range of 0 to 1 with higher 
values indicating a rhythm with higher amplitude. 

 

6.5 Replacing a missing period of data 

Where there are short periods of missing data where the watch was not worn, it is possible to 
replace the data to ensure continuous data for NPCRA. 

In the ‘Edit’ screen click and drag the start and end cursors to the period of data required. It is 
also possible to type the date/time into the ‘start of edit’ and ‘end of edit’ fields. 

Next use the control to change either ‘Activity’ or ‘Light’ data. 

Now select ‘Average of this period on days before & after’; the control will display in brackets 
the average value for the selected period. 

Now click the ‘Apply Change’ button – the selected period will have the data replaced with the 
average of the corresponding period for the days prior to and after the selection. 
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6.6 Excluding full days from NPCRA 

If much of any day has missing data where the watch was not worn, it is possible to exclude 
the day(s) from the NPCRA analysis. Use either ‘select days’ to choose individual days or 
‘select all’ to edit more than one period. 

In the ‘Edit’ screen enter the date/time into the ‘start of edit’ and ‘end of edit’ fields using 
00:00:00 for the times to ensure full days are selected. 

Select ‘Change data to: Missing data’, and click the ‘Apply Change’ button – the selected day 
will be highlighted in grey and will be excluded from any subsequent NPCRA analysis. 

This process can be repeated for more than one day. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select 
Activity or 

light. 

Select 
‘Average of 
this period 
on days 
before & 
after.’ 

Excluded 
days 

highlighted in 
grey 
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6.7 Restore original data 

The original data are not lost during the edit. To restore the original data, use the cursors to 
include the edited period then select ‘change data to: Original data’. The edited period will be 
restored to the original data. 

 

6.8 Exporting NPCRA Analysis Results 

The ‘Copy Statistics’ button will allow you to transfer the overall statistics easily into a 
spreadsheet program or similar.  Simply click the button, transfer to a spreadsheet window on 
your computer, and use the paste function to create a table of your results. 

 

6.9 Printing NPCRA Analysis Results 

Click on the ‘Print Preview’ button to preview the report and click on the ‘Print’ button to send 
the report to the printer. 

 

6.10 Save NPCRA Analysis Period 

Click on the ‘Save Period’ button to save the selected analysis. Long periods are not 
highlighted in the MotionWise window as they would hide shorter periods and become 
confusing. Instead use the ‘Longer periods’ menu from the MotionWise window to select any 
saved periods greater than 24 hours. 
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7 The 24-Hour Average Plot 

7.1 Select Data for Analysis 

From the MotionWise window, use the ‘select days’ option to choose a range of days or use 
the ‘select all’ option to analyze all days. The analysis window will open automatically; if not 
already selected, select ‘24h Average’ from the analysis functions side bar. A screen similar to 
that shown below will be displayed. 

 

 

Smoothing Period 

The smoothing period allows a time constant to be applied to the plotted data which is useful 
when analyzing for trends. The period may be selected between no smoothing and 60 
minutes. 

Daytime Period 

It is possible to specify the start and end of the daytime period to be used for the analysis. 
This will affect the daytime and nighttime average values accordingly. 

Activity Average 

The data per epoch for each day are day totalized and averaged over the number of days in 
the analysis. The average activity in the daytime and nighttime periods are then calculated 
and displayed. Note MW counts are MotionWatch counts. 

Day/Night Average Ratio 

This is the daytime activity average / nighttime activity average. 

Fitted Cosine Peak 

A cosine is fitted to the averaged data and the time of day where the cosine peak occurs is 
displayed.  
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8 Nap Analysis 
 

8.1 Overview 

The Nap analysis function allows detection of periods of inactivity that could be attributed to 
daytime napping or micro-sleeps. The function provides user adjustable parameters for 
duration and threshold to detect the potential naps. 

 

8.2 Select Data for Analysis 

From the MotionWise window, use the ‘select any’ option to a period of data to analyze – this 
will typically be during the normal active daytime period. The analysis window will open 
automatically; if not already selected, select ‘Napping’ from the analysis functions side bar. A 
screen similar to that shown below will be displayed. 

 

8.3 Select Nap Activity Threshold 

The ‘Napping activity level (/epoch)’ is used to set the activity threshold for nap detection. The 
activity level in every epoch within the specified period must be less than or equal to the 
entered value for the period to be scored as a nap. For example, if the threshold is set to 10, 
the period will be scored as a nap if every epoch <=10 counts. Change the threshold value by 
typing the number of counts. 

8.4 Select Min Nap Length 

Set the minimum period of inactivity required to be scored as a nap. The value should be 
typed in the format hh:mm:ss. Periods shorter than the selected value will not be scored as a 
nap period. 

8.5 Select Max Nap Length 

Set the maximum period of inactivity required to be scored as a nap. The value should be 
typed in the format hh:mm:ss. Periods longer than the selected value will not be scored as a 
nap period. 
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8.6 Analysis Results 

The analysis window will show the number of potential naps detected. The analysis graph will 
display the potential nap periods as green highlighted areas. 

8.7 Export Nap Periods 

To export the nap analysis details, click on the ‘Export Nap periods’ button. The nap analysis 
details will be copied to the clipboard which may then be pasted into Excel or similar for 
further analysis. 
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9  Physical Activity (Day) Analysis 
 

9.1 Overview 

The physical activity analysis function provides an overview and summary of the activity levels 
of the wearer during the daytime. It is intended to assist in monitoring of the amount of time 
spent active on a daily or weekly basis, and the approximate intensity of that activity.  

To use the analysis function, single click to select a recording from the recent files list and 
then click the “Physical Activity Analysis” button. 

9.2 Physical Activity Analysis 

Once the recording has been opened, the Day Analysis window will show as below. It allows 
you to step through every day of the recording and see the highlighted activity periods and 
daily summary data. 

 

 

Selecting Days 

To select which day of the recording to view, note the sequence of small day graphs across 
the top of the Day Analysis window. You can click on any of these to view that day in more 
detail below. You can also scroll this selection to view more days later in the recording. Days 
which contain some moderate or vigorous activity are highlighted with the “M” or “V” stamp 
respectively on the quick selection view. 
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Excluding Sleep Periods 

Within the Tools menu, you can choose to exclude sleep periods from the daytime activity 
analysis. Note that this will only exclude time periods explicitly saved as sleep from the Sleep 
Analysis function of the software. It will not automatically detect sleep periods for exclusion 
from Day Analysis. However, it is possible to automatically mark for sleep within a recording 
from within Sleep analysis (with some limitations), and then use this function to exclude those 
periods. 

Highlighted Activity Graph 

The main activity graph in the Day Analysis window highlights periods of constant activity – 
those where higher levels of movement are maintained for 10 minutes or more.  You can 
control whether moderate and vigorous periods are highlighted in this way using the View 
menu of this window.  

Summary Activity 

Below the main activity graph, a bar chart summarises the amount of time spent in constant 
activities of vigorous, moderate or low intensity alongside sedentary time. The table of results 
below this includes both the constant totals drawn in the bar chart and highlighted on the 
activity graph (where only 10 minute or greater periods are counted), and the total times in 
each category (where every epoch is counted). 

Definition of Results 

The following tables describe the criteria used when categorising time expenditure:  

 

Vigorous Activity Time The total amount of time when the activity count 
exceeds the ‘Vigorous’ calibration threshold. 

Moderate Activity Time The total amount of time when the activity count is 
greater than or equal to the ‘Moderate’ calibration 
threshold and is less than ‘Vigorous’ threshold. 

Low Activity Time The total amount of time when the activity count is 
greater than or equal to the ‘Sedentary’ calibration 
threshold and is less than ‘Moderate’ threshold. 

Sedentary Activity Time The total amount of time when the activity count is 
greater than zero and is less than the ‘Sedentary’ 
threshold. 

Empty Time The total amount of time when the recording did 
not take place – such as at the start or end of the 
recording (for example the difference between 
00:00 and the start time or the end time and 
24:00). 

Non-zero Time Any data within the recording with a count value 
above zero. 

Zero Time Any data within the recording with a count value 
of zero. 

 

If the ‘Show Only Continuous Activity’ option is checked under the ‘View’ menu, ‘Vigorous 
Activity Time’ and ‘Moderate Activity Time’ are replaced with: 
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Continuous Vig. Activity As ‘Vigorous Activity Time’, but only when the 
amount of time is 10 minutes or more. 

Continuous Mod. Activity As ‘Moderate Activity Time’, but only when the 
amount of time is 10 minutes or more. 

 

9.3 Set Calibration 

It is possible to set the calibration for the intensity of activity used in classification. This can be 
done by selecting the “Set Calibration” function from the ‘tools’ menu.  

The analysis function uses a calibration to derive reference thresholds for vigorous, moderate, 
low and sedentary activity types. These values differ from patient-to-patient depending on 
their capabilities, so it is desirable to perform a calibration for each patient or recording (where 
applicable). 

The best way to calibrate a recording is to arrange for the patient to perform a brisk walk (3-4 
mph) for at least 5 minutes. This should take place at the start, or at the end of a recording to 
ensure that it is easily identifiable when selecting it in the calibration window [1]. 

The calibration period can be selected by either clicking the highlighted period in the activity 
graph [2], or by selecting a reported period in the detected periods list [3]. The selected period 
will use an average of the activity counts found within the period to produce the moderate 
threshold. This value will also be used to derive the vigorous and sedentary thresholds. The 
low threshold accounts for any values found between the sedentary and moderate thresholds.    

The entire recording will be analysed to detect any bouts of activity which are longer than 5 
minutes and who’s activity counts are within an acceptable range. These can be selected as 
alternative calibration values but they may not reflect the values of a brisk walk and should be 
used with caution. Calibration periods can also be selected manually by dragging the mouse 
cursor over a period on the activity graph, or by entering fixed values in the thresholds fields 
[4].  

 
 
  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

[1] Calibration Window [2] Detected Calibration Periods 

[3] Detected Calibration List [4] Threshold Fields 
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9.4 Definition of MVPA 

Physical activity includes everyday activity such as walking and cycling to get from A to 
B, work-related activity, housework, DIY and gardening. It also includes recreational 
activities such as working out in a gym, dancing, or playing active games, as well as 
organised and competitive sport. (See the Chief Medical Officers' [CMOs'] report.) 

9.5 National recommendations 

The CMOs' current recommendations for physical activity (see UK physical activity 
guidelines) state that: 

 

All adults aged 19 years and over should aim to be active daily. 

• Over a week, this should add up to at least 150 minutes (2.5 hours) of moderate 

intensity1 physical activity in bouts of 10 minutes or more. 

• Alternatively, comparable benefits can be achieved through 75 minutes of vigorous 

intensity2 activity spread across the week or combinations of moderate and vigorous 

intensity activity. 

• All adults should also undertake physical activity to improve muscle strength on at least 

2 days a week. 

• They should minimise the amount of time spent being sedentary (sitting) for extended 

periods. 

• Older adults (65 years and over) who are at risk of falls should incorporate physical 

activity to improve balance and coordination on at least 2 days a week. 

• Individual physical and mental capabilities should be considered when interpreting the 

guidelines, but the key issue is that some activity is better than no activity. 

1 Moderate-intensity physical activity leads to faster breathing, increased heart rate and 
feeling warmer. Moderate-intensity physical activity could include walking at 3–4 mph, 
and household tasks such as vacuum cleaning or mowing the lawn. 

2 Vigorous-intensity physical activity leads to very hard breathing, shortness of breath, 
rapid heartbeat and should leave a person unable to maintain a conversation 
comfortably. Vigorous-intensity activity could include running at 6–8 mph, cycling at 
12–14 mph or swimming slow crawl (50 yards per minute). 

NICE Public Health Guidance [PH44], 2013 
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9.6 Weekly Summary 

The Weekly Summary window can be opened through the Tools menu of the Day Analysis 
window. It shows a graph of the wearer’s activity levels over a single week at once: 

 

 

 
Selecting a Week 

The available weeks can be scrolled through in the first graphic of the Weekly Summary 
window. Use the scroll bar at the right to move through the weeks and view the week of 
interest.  

Note that using the Options menu, the weeks can be chosen to begin either on Monday 
(Calendar Week), or on the first day of the recording (Consecutive Week). 

Weekly Summary Graph 

The main graph in the Weekly Summary window shows the time spent in different constant 
intensity levels on each day of the selected week. You can see both how the time each day 
compares to the target time illustrated by the black line, and how it varies across the week. 
For instance, the graphic above clearly shows that whilst the target for moderate activity was 
missed during most of the week, the wearer was then very active on Saturday. The View 
menu can be used to turn on and off the highlighting of Low, Medium and Vigorous levels. 
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Weekly Summary Totals 

Below the summary graph, a bar chart illustrates the total amounts of time spent in each of 
Vigorous, Moderate and Low activity, and Sedentary time. Along with the graph above, this 
will be updated as the weeks of the recording are stepped through. The bar graph also shows 
the target black line, controlled by the weekly exercise target figure below it. 

 

9.7 Totals & Averages 

The Totals & Averages window can be opened through the Tools menu of the Day Analysis 
window. This window is designed to illustrate the variation of activity over the full length of the 
recording. The upper graph shows the changes between weeks, and the lower graph shows 
the average variation within weeks. 

 

 

 
Weekly Totals 

The upper graph of the Totals & Averages window shows the total time spent in different 
activity bands over the weeks of the recording.  In the example shown, the recording spanned 
over 6 weeks and showed relatively steady levels apart from an increase in week 4 and a 
lower total in week 6. It is easy to see both the absolute level versus the target black line (set 
at the bottom of the window), and the variation between weeks. 

 



MotionWare Software User Guide: Issue 1.4.25  Page 42 
 

Day of Week Averages 

The lower graph of the Totals & Averages window is produced by averaging each weekday 
across all weeks of the recording. This shows up any variation caused by weekly patterns of 
behaviour. In the example shown the wearer is clearly far more active on Saturday than on an 
average weekday, but there is more variation within those also. 

 

Note that both graphs can be affected by the View and Options menus.  The View menu 
controls whether highlights are shown for each of the intensity levels.  The Options menu 
controls whether the discrete weeks are considered to always start on a Monday (Calendar 
Week), or on the first day of the recording (Consecutive Week). 
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10 Bulk Data Export Functions 
 

10.1 Overview 

After many individual recordings are collected, it is sometimes useful to perform a bulk export, 
when an entire folder of recording files will be analysed and the results collated in one step. 
These functions are available from within the “Bulk Export” button on the main menu. 

10.2 Bulk Raw Data Export 

This function allows you to export the raw data from every motion file in a directory into 
corresponding csv files. It may be useful if you wish to analyse the data yourself using a 
spreadsheet or programming environment rather than using the MotionWare software.  

10.3 Bulk Results Export 

The Bulk Result Export will export all of the analysed recordings in a folder, producing a single 
row of results per recording. Results where there are multiple periods will have their results 
averaged into a single set. This applies to the Sleep, Day, Nap and NPCRA (if applicable) 
functions.  

Note: It is recommended to analyse your recordings fully before using this 
function for maximum usefulness. 

Recordings which have not been analysed will produce empty results in the 
export for the particular set(s) of results. 

  

10.4 Bulk Day Activity Export 

The Bulk Day Activity Export function will analyse a folder of recordings using consistent 
thresholds for physical activity.  

This function may be less accurate than using individually calibrated threshold levels for each 
participant to assess their activity against recommendations, but allows a consistent 
comparison across all recordings. 

After selecting the options for thresholds of physical activity, you can also choose: 

 

Minutes of zero data to 
classify as not worn 

The software will automatically ignore periods where the watch 
was not worn if this option is set. A value of 0 will disable the 
option. A value of 120 (2 hours) will exclude most not-worn data 
while being unlikely to occur by accident, even in elderly or 
inactive participants. 

Hours of data required 
in a day to use that day 

This value will select how many hours are required to be worn in 
a day in order to include it in the analysis. It allows participants 
to avoid wearing the device overnight if their sleep is not of 
interest. 

Results Separator This may be either Tab, Space or Comma. Using a Tab 
separator will usually make it easier to paste the results into 
Excel or analyse with other software.  A Comma separator, or 
explicitly choosing a .csv file output, will separate values with 
commas. This option should be used with care as it will produce 
problematic results with an operating system country set to use 
comma symbol as decimal separator. 
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Appendix A – Utilities 
 

A1 – Actiware Import  

Legacy Philips Actiwatch Spectrum or Actiwatch 2 data may be loaded into MotionWare by 
first exporting from Philips Actiware software into .CSV file format. MotionWare will load the 
.CSV file and convert it into .AWD file format which can then be viewed and analysed in 
MotionWare. The import function will include Activity, light and marker data depending upon 
what is included in the Actiware export. 

Two steps are required to import the data: 

 

1. Export the data in CSV format from the Actiware Software. 

2. Open the CSV in MotionWare and save the resulting .AWD file. 

 
Step 1 – Export the CSV 

• In the Actiware Software, select new analysis and then click the Actogram button 
to show the graph of the required data. 

• Next set up the Actiware report generation (you should only need to do this once). 

• From the tools menu, select ‘options’ and then click on the export tab. Ensure that 
the ‘full header’ and ‘epoch-by-epoch list’ options are checked. 

• Now click the ‘data list’ tab and ensure that the ‘activity’ (and optionally ‘photopic 
light’) option is checked. 

• Click OK to save and close the options window. 

• From the main file menu, select the ‘export…’ option – ignore the ‘reminder’ pop-
up. 

• You can now choose the file name and location and then save the export data as 
a csv file. 

 
Step 2 – Load the CSV Data into MotionWare 

• Click the Browse button from the MotionWare front screen. 

• In the file open dialog, click on the file type drop down to select ‘Actiware Import 
(*.CSV)’ (see below). 

 

 
 

• Browse to locate your CSV file saved in step 1 and click ‘Open’ 

• The Actiware CSV Import screen should be displayed similar to that shown below: 
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• The user ID, Gender etc. from the exported CSV file should be displayed. 

• Confirm that the recording details are correct in the display. 

• If the details are not correct, the export may not be in the correct format – please 
ensure the correct settings were applied in Actiware for CSV export. 

• Click ‘Save AWD File’ to generate the output file. 

• The Actiware import window will close and the converted file will automatically 
appear at the top of the recent files list in the MotionWare front screen. 

• Double-click to open the file. 
 
 
NOTE: The Philips Actiware export format has changed with new major software releases. If you 
have an Actiware CSV export file that will not load into MotionWare, please contact us at 
admin@camntech.co.uk and we will try to assist you further. 

 

  

mailto:admin@camntech.co.uk
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From 
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1.2.26 1.2.26a 14/02/19 Updates for MDR review, Updated SW  installation instructions HS 
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Medical Device Regulation EU 2017/745. Updated EMI/EMC compatibility information. 

HS/
MD 

1.2.28 1.2.35 13/11/19 Updated to include Auto-Sleep analysis instructions. TE 

1.2.35 1.2.36 27/11/19 Updated CamNtech address, removed Windows 7 HS 

1.2.36 1.2.36a 03/12/19 Updated table of contents (missed from issue 1.2.35) HS 

1.2.36a 1.2.42 01/03/20 Added section 5.16 for Temperature data import TE 

1.2.42 1.2.44 29/05/20 Clarified description of tri-axial counts to the same wording as uniaxial for latter stages TE 

1.2.44 1.2.46 03/06/20 Updated battery life indications and battery gauge to match software HS 

1.2.46 1.2.47 11/06/20 Added NPCRA edit instructions to section 7. HS 

1.2.47 1.3.12 11/09/20 Added specific notes for Mac version installation and where appropriate elsewhere.  Updated 
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TE 
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1.3.16 1.3.17 06/01/21 Minor updates following EC Rep review HS 

1.3.17 1.3.17a 25/06/21 Updated contraindications and decontamination sections to minimise risk of skin irritation due 
to residual cleaning agents. 

HS 

1.3.17a 1.3.17b 07/12/21 Corrected menu selection in ‘excluding sleep periods’ for daytime activity. HS 

1.3.17b 1.3.33 30/06/22 Added CH-REP details, bump version no. to match software release. HS 

1.3.33 1.3.33a 16/11/22 Updated and extended coin cell battery warning throughout HS 

1.3.33a 1.4.14 12/06/23 Separated into software only, updated visual styles, checked and updated all sections HS 

1.4.14 1.4.25 18/01/24 Updated for Actiware import HS 

     

     

     

     

     

     

     

     

 


